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Vorwort 

Literaturverwaltungsprogramme unterstützen Nutzerinnen und Nutzer bei der Verwaltung ih-

rer Literaturangaben und bei der Erstellung wissenschaftlicher Arbeiten. Die Universitätsbib-

liothek Heidelberg bietet neben Veranstaltungen und Beratungen zur fachlichen Recherche 

seit vielen Jahren Schulungen zum Thema Literaturverwaltungsprogramme an. 

Diese Kurzanleitung soll Nutzerinnen und Nutzern von EndNote einen niedrigschwelligen 

Einstieg zur Bedienung des Programms bieten. Die Grundidee von Literaturverwaltungspro-

grammen besteht i.d.R. aus dem dreiteiligen Prozess des Datenerfassens, -verwaltens und 

-zitierens. Dieser Prozess wird im Verlauf der Kurzanleitung abgebildet. 

Diese Anleitung beschränkt sich auf die Beschreibung der Grundfunktionen. Ausgangspunkt 

ist das kursbegleitende Skript Literaturverwaltung mit EndNote (2021). Für eine ausführliche 

Beschreibung und weitere Themen wie bspw. die Installation des Programms schauen Sie 

bitte in das Skript bzw. einzelne Handouts, die auf der Webseite der Universitätsbibliothek 

Heidelberg zur Verfügung stehen. 

Die Kurzanleitung basiert auf der Version von EndNote 20. Die Funktionen und Screenshots 

werden auf der Basis der Windows-Version von EndNote dargestellt. Da das Programm eine 

englischsprachige Oberfläche hat, werden in dieser Kurzanleitung die englischen Begriffe 

belassen. 

Heidelberg, 29.8.2022 

Kontaktadresse: schulung@ub.uni-heidelberg.de 

  

https://www.google.com/url?sa=t&rct=j&q=&esrc=s&source=web&cd=&ved=2ahUKEwjJ1fDRuuz5AhUGRPEDHW6bADQQFnoECB0QAQ&url=https%3A%2F%2Fwww.ub.uni-heidelberg.de%2Fschulung%2Fliteraturverwaltung%2Fendnote%2Fmaterialien%2FUBHD_EndNote20_Skript.pdf&usg=AOvVaw3-2e540rrJm5bZk1EK_KpL
https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/Welcome.html
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1. Eine neue Library erstellen 

Sie haben zwei Optionen, um eine neue Library anzulegen: Entweder über das Fenster in 

der Abbildung über den Button Create a new library oder über die Menüleiste über File → 

New… In beiden Fällen öffnet sich die Auswahl Ihres Speicherortes der Library. Standard-

mäßig lautet der Dateiname My EndNote Library. Sie können diesen so belassen, ihn erwei-

tern oder einen komplett neuen Namen für Ihre Library vergeben. Wählen Sie anschließend 

den Speicherort aus und klicken Sie abschließend auf Speichern. 

 

 

Abbildung 1 - Startfenster EndNote 

 

 

Abbildung 2 - Speicherort der Library auswählen und diese benennen 
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2. Dateimanagement 

Ihre EndNote-Library besteht aus einer Datei mit der Endung .enl und einem DATA-Ordner 

mit dem gleichen Namen. Der DATA-Ordner enthält u.a. angehängte PDF-Dateien, die Grup-

pen und Term Lists. Wenn Sie eine Kopie Ihrer Library z.B. mit Copy & Paste sichern möch-

ten, müssen Sie die Datei und den Ordner kopieren, damit Ihre Library weiterhin funktioniert 

und Sie keine Datenverluste erleiden. 

 

 

Abbildung 3 - vollständige Library: enl-Datei und Data-Ordner 

 

Speichern Sie Ihre EndNote-Library auf der eigenen Festplatte und nicht auf einem Cloud-

Service wie z.B. Dropbox oder einem lokal synchronisierten Laufwerk über OneDrive oder 

iCloud. EndNote speichert Änderungen an der EndNote-Library in einer bestimmten Reihen-

folge. Bei gleichzeitiger Synchronisierung einer Datei durch einen Clouddienst kann EndNote 

nicht speichern. Auf Dauer kann dies zu einer Beschädigung bis hin zur Unbrauchbarkeit 

Ihrer EndNote-Library führen. Wenn Sie diese Speicherorte für Sicherheitskopien Ihrer End-

Note-Library verwenden, laden Sie die EndNote-Library vor dem Öffnen und Bearbeiten auf 

Ihren Desktop herunter. 

Sowohl der Software-Hersteller von EndNote als auch die Universitätsbibliothek Heidelberg 

empfehlen das Anlegen von und das Arbeiten mit nur einer einzigen Library. Falls Sie an 

mehreren verschiedenen Projekten arbeiten und diese in EndNote abbilden möchten, emp-

fehlen wir die Strukturierung Ihrer Referenzen über sogenannte Custom Groups oder Group 

Sets. Diese Empfehlung hat folgenden Hintergrund: Sie können aus technischen Gründen 

nur eine Library mit dem unternehmenseigenen Cloud-Service von EndNote synchronisieren. 

Die Synchronisationsfunktion benötigen Sie beispielsweise, wenn Sie an verschiedenen 

Computern an Ihrer Library arbeiten möchten oder auch wenn Sie im Team an einer Library 

arbeiten. 
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3. Die Programmoberfläche von EndNote 20 
 

 

 

 

 

 

Abbildung 4 - Screenshot der Sample Library 

 

 

 
 

 

 

4. Referenzen erfassen 

Referenzen können auf unterschiedliche Arten in eine EndNote-Datenbank aufgenommen 

werden: 

• Manuelle Erfassung 

• Export aus Katalogen und Fachdatenbanken nach EndNote (weitere mögliche Quel-

len wären wissenschaftliche Suchmaschinen, Fachportale und elektronische Fach-

zeitschriften) 

• Über die Online Search aus EndNote heraus 

• Import aus PDF-Dateien mit DOI-Nummern. 

 

Über die Menüleiste kön-

nen Sie alle Funktionen 

von EndNote aufrufen 

Über den Groups Pa-

nel werden perma-

nente, temporäre und 

selbsterstellte Grup-

pen angezeigt. 

Über die erweiterte 

Suche können Sie 

sowohl Ihre Library 

als auch verschie-

dene Online-Daten-

banken durchsuchen 

 

Über die Reference List 

können Sie Referenzen an-

wählen, sortieren, markieren, 

etc. 

Über die Summary- und Edit-

Tabs werden alle Infos zu ei-

ner   gewählten Referenz an-

gezeigt bzw. bearbeitet 

Über den Preview Subpanel se-

hen Sie, wie eine gewählte Refe-

renz nach einem bestimmten Zitier-

stil im Literaturverzeichnis ausge-

geben wird 

Über die Icons in der 

Symbolleiste lassen 

sich häufig benötigte 

Funktionen schnell 

aufrufen 
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4.1. Manuelle Erfassung von Referenzen 

Über References > New Reference oder das Icon mit dem Plus in der Symbolleiste können 

Sie ein leeres Fenster zur Erfassung einer Referenz aufrufen: 

 

Abbildung 5 - Fenster zur manuellen Erfassung der bibliographischen Daten 

 

Das Handout zu den EndNote-Referenztypen gibt eine Übersicht über alle Referenztypen in 

EndNote. Geben Sie alle Angaben unformatiert ein. Formatierungen wie Fett, Kursiv, etc. 

und Funktionsbezeichnungen wie bspw. „Hrsg.“ oder die Abkürzung einer Seitenangabe wer-

den über den Zitierstil bei der Erstellung einer Bibliographie automatisch hinzugefügt. Wei-

tere Regeln zur korrekten Erfassung der bibliographischen Daten finden Sie auf Seite 8 und 

9 des Skripts zur Literaturverwaltung mit EndNote. 

 

4.2. Export aus Katalogen, Datenbanken, etc. 

 

4.2.1. Export aus dem Online-Katalog HEIDI 

Der Prozess des Exports von bibliographischen Daten aus einem Bibliothekskatalog wird am 

Beispiel des Bibliothekskatalogs der Universitätsbibliothek Heidelberg namens HEIDI darge-

stellt. Die Logik des Exports funktioniert bei anderen Online-Bibliothekskatalogen in ähnlicher 

Form. 

Grundsätzlich gibt es zwei Möglichkeiten bibliographische Daten aus dem Online-Katalog 

HEIDI in EndNote zu exportieren bzw. zu importieren. Im Folgenden wird die übliche Vorge-

hensweise beschrieben, wie Sie eine einzelne Referenz aus HEIDI exportieren. Falls Sie 

ganze Trefferlisten aus HEIDI exportieren möchten, finden Sie hier das entsprechende Hand-

out. 

 

Über Reference Type kön-

nen Sie den passenden Refe-

renztyp wählen 

Erfassen Sie den Namen des 

Autors/Herausgebers in der 

Form: Nachname, Vorname 

und verwenden Sie einen 

Namen pro Zeile 

 

https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/materialien/EndNote-Referenztypen.pdf
https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/materialien/UBHD_EndNote20_Skript.pdf
https://archiv.ub.uni-heidelberg.de/volltextserver/29824/
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1. Führen Sie Ihre Suche im Katalog HEIDI wie gewohnt durch. 
2. Klicken Sie auf einen Titel in der Trefferliste, um die Vollanzeige der Referenz zu 

sehen. 
3. Klicken Sie in der grauen Spalte auf Exportieren/Zitieren. 
4. Wählen Sie im Dialogfenster das Format RIS (EndNote) und speichern. (Hinweis: In 

den Firefox-Einstellungen unter „Anwendungen“ muss bei RIS (Research Information 
System Format) „Jedes Mal nachfragen“ stehen“). 

5. Klicken Sie im nächsten Fenster auf Öffnen mit: EndNote 20 und bestätigen Sie die 
Auswahl mit OK. 

6. Die Titel der Importdatei werden in Ihre EndNote-Library übernommen und in der Re-
ference List angezeigt. Bitte überprüfen Sie die Daten nach dem Import und korrigie-
ren diese ggf. manuell. 

 

 

Abbildung 6 - Punkt 3: Klicken Sie auf "Exportieren/Zitieren" 

 

 

Abbildung 7 - Punkt 4: Wählen Sie das RIS-Format aus und klicken auf "speichern" 
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Abbildung 8 - Punkt 5: Wählen Sie "Öffnen mit: EndNote" aus 

 

4.2.2. Export aus Fachdatenbanken 

Fachdatenbanken unterscheiden sich in der Regel hinsichtlich ihrer Benutzungsoberflächen. 

In den meisten Fällen können Sie über die folgenden Schritte Referenzen aus den Fachda-

tenbanken exportieren und in EndNote importieren. 

1. Führen Sie Ihre Suche wie gewohnt in der jeweiligen Datenbank durch. 

2. Markieren Sie die zu importierenden Treffer. 

3. Klicken Sie je nach Datenbank auf Export, Speichern / Save oder Send To. 

4. Wählen Sie je nach Datenbank das Exportformat EndNote, RIS oder Citation Manager 

(für den Export aus PubMed) aus. 

 
Beispiel: Export aus der MLA International Bibliography (Datenbankanbieter: EBSCO) 

 

Abbildung 9 - Screenshot zum Export aus MLA – Referenzen in die Merkliste schieben 
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a) Markieren Sie die Treffer, die Sie nach EndNote exportieren möchten. 

b) Klicken Sie auf Go to Folder View, um den Exportordner aufzurufen. 

 

Abbildung 10 - Screenshot zum Export aus MLA – Referenzen exportieren 

 

c) Klicken Sie auf Select all oder markieren Sie einzelne Treffer, die Sie übernehmen 

    möchten. 

d) Klicken Sie auf Export. 

 

Abbildung 11 - Screenshot zum Export aus MLA - Exportvorgang initiieren 

 

e) Klicken Sie auf Direct Export in RIS Format ... und danach auf Save. 
 

Die Universitätsbibliothek Heidelberg bietet verschiedene Handouts mit der Beschreibung 

des Exports aus Fachdatenbanken an. Für den Import von Referenzen aus Google Scholar 

gehen Sie bitte nach dem hier verlinkten Handout vor. 

 

 

 

 

 

https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/import.html
https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/faq/AN/UBHD_Handout_EndNote_Benutzung_andere_Anwendungen_04.pdf
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4.3. Online Search von EndNote 

Falls bestimmte Fachdatenbanken keiner Lizenz unterliegen und diese über eine Connection 

File verfügen, können Sie in diesen Datenbanken direkt aus EndNote heraus nach Literatur 

recherchieren. Wählen Sie dazu im Groups Panel unter der Online Search die entsprechende 

Datenbank aus und geben Sie Ihre Suchbegriffe im Suchfenster ein. Falls die gewünschte 

Datenbank im Groups Panel nicht angezeigt wird, klicken Sie auf more und suchen im 

dadurch aufgerufenen Connection Manager danach (alternativ öffnen Sie diesen über Tools 

→ Connection Files → Open Connection Manager). Markieren Sie ein oder mehrere Sucher-

gebnisse und fügen Sie diese durch das Anklicken des Plus-Zeichens Ihrer Library hinzu. 

 

Abbildung 12 - Suchergebnisse aus der Online-Search der eigenen Library über das Plus-Zeichen hinzufügen 

 

4.4. Import aus PDF-Dateien mit DOI-Nummern 
Falls Sie direkt in einer Fachdatenbank einen Volltext mit einem Document Object Identifier 

(DOI) heruntergeladen haben, können Sie die PDFs in EndNote importieren. Die bibliogra-

phischen Daten des Dokuments werden dann ausgelesen und als Datensatz in EndNote 

hinterlegt. Gehen Sie nach dem Download der Dokumente in EndNote auf File → Import → 

File und wählen die entsprechenden PDFs aus. Als „Import Option“ wählen Sie „PDF“. 

 

 

5. Suche nach frei verfügbaren und lizenzierten Volltexten 

Falls Sie die Volltexte von Online Journals direkt in EndNote lesen und bearbeiten möchten, 

nehmen Sie bitte die Einstellungen aus dem Handout zur Nutzung elektronischer Volltexte 

über EndNote vor. 

 

 

6. Dublettenkontrolle 

Bevor Sie anfangen, Referenzen in Ihre Dokumente einzufügen, sollten Sie Ihre EndNote- 

Library auf doppelt vorhandene Datensätze überprüfen und diese löschen, da dublette 

Referenzen beim Schreiben von Dokumenten Schwierigkeiten verursachen können. 

https://endnote.com/downloads/connection-files/
https://endnote.com/downloads/connection-files/
https://archiv.ub.uni-heidelberg.de/volltextserver/29724/
https://archiv.ub.uni-heidelberg.de/volltextserver/29724/
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Achten Sie darauf, dass die Gruppe All References markiert ist und klicken Sie auf 

Library > Find Duplicates. Es öffnet sich ein Fenster, in dem dublette Datensätze nebenein- 

ander angezeigt werden. Sie können in der Anzeige nach unten scrollen. Unterschiede in 

der Feldbelegung werden hervorgehoben. Wenn Sie entschieden haben, welche Referenz 

Sie behalten möchten, klicken Sie auf Keep This Record. Die andere Referenz wird aus Ihrer 

Datenbank gelöscht. 

 

Abbildung 13 – Dublettenkontrolle 

 

 

7. Referenzen mithilfe von Gruppen verwalten 

Über den Groups Panel auf der linken Seite werden permanente, temporäre und selbster-

stellte Gruppen angezeigt. 

Zu den permanenten Gruppen, die immer angezeigt werden, gehören: 

• All References: Anzeige aller Referenzen Ihrer EndNote-Library. 

• Recently Added: Anzeige von Neuzugängen in Ihrer EndNote-Library standardmäßig 

für 24 Stunden. Mit Rechtsklick auf den Gruppennamen kann das Kontextmenü auf-

gerufen und der Zeitraum für die gerade genutzte Library auf max. 30 Tage erhöht 

werden. 

• Unfiled: Anzeige von Referenzen, die keiner Custom Group zugeordnet wurden. 

• Trash: Nicht mehr benötigte Referenzen können mit Drag & Drop in den Papierkorb 

verschoben werden. Sie bleiben dort so lange erhalten, bis Sie den Papierkorb leeren 

(Kontextmenü mit rechter Maustaste aufrufen und Empty Trash auswählen). 

 

Es gibt verschiedene temporäre Gruppen, die automatisch erscheinen, wenn Sie bestimmte 

Funktionen in EndNote ausführen. 
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• Dokument der eingefügten Referenzen: Falls Sie Referenzen in Word einfügen, wer-

den diese automatisch in einer eigenen Gruppe mit dem entsprechenden Dokumen-

tennamen angezeigt. 

• Duplicate references: Die Gruppe zeigt Ihnen die Ergebnisse einer Dublettensuche 

(Library → Find duplicates) 

• Importes References: Diese Gruppe zeigt die zuletzt in die Library importierten Refe-

renzen an und wird jedes Mal ersetzt, wenn Sie eine neue Gruppe von Referenzen 

importieren. 

• Find Full text Group Set: Wenn Sie die Find Full text-Funktion ausführen, erscheinen 

verschiedene Gruppen (Searching, Found PDF, Found URL, Not found) 

 

Der Softwarehersteller von EndNote empfiehlt nur eine EndNote-Library zu nutzen und mit 

Hilfe von selbsterstellten Gruppen zu unterschiedlichen Themen / Aspekten für Ordnung 

und Übersichtlichkeit zu sorgen (wie bereits in Kapitel 2 erwähnt). Durch diese Vorgehens-

weise haben Sie die größtmögliche Flexibilität im Kontext des Teilens von Gruppen und Bib-

liotheken. 

Es gibt verschiedene Arten von selbsterstellten Gruppen und Hierarchien: 

• Mithilfe eines Group Sets (Obergruppe) legen Sie eine zweistufige Hierarchie an 

(Groups → Create Group Set). Per Drag & Drop können Sie dem Group Set Custom 

Groups zuweisen. 

• Custom Groups sind sozusagen Standardgruppen, die Sie manuell anlegen und be-

nennen (Group → Create Group) und denen Sie per Drag & Drop Referenzen zuord-

nen können. 

Im technischen Sinne sind die Referenzen, die in verschiedenen Gruppen liegen, ei-

gentlich Verknüpfungen zu den ursprünglichen Referenzen, die immer in der Gruppe 

All references liegen. Dementsprechend können Sie eine einzelne Referenz mehre-

ren Custom Groups zuordnen und falls Sie eine Custom Group löschen, werden nur 

die Verknüpfungen gelöscht. Falls Sie allerdings einzelne Referenzen aus den Grup-

pen in den Papierkorb schieben, löschen Sie damit die ursprüngliche Referenz aus 

der Library. 

• Smart Groups werden aus einer Suchanfrage heraus generiert, indem die Referen-

zen, die den Suchkriterien entsprechen, der Smart Group automatisch zugeordnet 

werden. Neu in die EndNote-Library aufgenommene Referenzen, die den Suchkrite-

rien entsprechen, werden der Smart Group künftig automatisch zugeordnet. 

Mit Hilfe einer Smart Group kann eine ganze EndNote-Library inkl. PDF-Anhängen 

sehr schnell nach Begriffen durchsucht werden. 

Um eine Smartgroup zu erstellen, geben Sie Ihre Suchbegriffe in die Suchmaske ein 

und klicken auf Search Options > Convert to Smart Group. 
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Abbildung 14 - Smart Group erstellen 

 

• Mit Combo Groups können Schnittmengen, Vereinigungsmengen oder Differenz-

mengen aus bereits bestehenden Gruppen gebildet werden (Groups → Create from 

Groups). 

 
 
Abbildung 15 - Beispiele für permanente, temporäre und selbsterstellte Gruppen 

Combo Group 

Group Set 

Custom Group 

Smart Group 

Find Full text 

Group Set 
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8. EndNote Sync und Library Sharing 

Falls Sie mit verschiedenen Rechnern an Ihrer Library arbeiten und bestimmte Gruppen für 

die Arbeiten im Team teilen möchten, gehen Sie bitte nach den im Folgenden verlinkten 

Handouts vor. 

Handout zur Anmeldung bei EndNote online und EndNote Sync 

Handout zum Library Sharing 

 

 

9. Referenzen in Word-Dokumenten 

Mit der Installation von EndNote wird automatisch das Word-Add-In von EndNote mitinstal-

liert. Der Name des Add-Ins beschreibt in geeigneter Form, was hiermit möglich ist: Cite while 

you write (CWYW) – also das Zitieren während des Schreibens einer wissenschaftlichen Ar-

beit. 

 

 

 

 

 

 

Abbildung 16 - Word Add-in "Cite while you write" 

 

9.1.  Zitate in den Text einfügen 
Wenn Sie ein Zitat in ein Dokument einfügen möchten, vergewissern Sie sich, dass Ihre 

EndNote-Library im Hintergrund geöffnet ist und der Cursor an der Stelle steht, an der das 

Zitat eingefügt werden soll. Klicken Sie dann auf Insert Citation. Es öffnet sich ein Fenster, 

in dem Sie z.B. nach Autorennamen, Titelstichwörtern oder anderen Begriffen in allen Fel-

dern Ihrer EndNote-Library suchen können. Markieren Sie in der Liste der angezeigten Tref-

fer die Referenz, die Sie zitieren möchten und klicken Sie auf Insert. Das Zitat wird nun im 

Text eingefügt und die Literaturliste am Ende des Dokumentes wird automatisch aktualisiert. 

Die Darstellung der Zitate im Text und der Referenzen in der Literaturliste wird über den 

eingestellten Zitierstil geregelt. Ihnen stehen im Dropdown-Menü die gleichen Stile wie in 

EndNote selbst zur Verfügung. Sie können auch hier im Dropdown-Menü über Select Another 

Style weitere Stile aus dem Style Manager übernehmen. 

Falls Sie einen Fußnoten-Stil verwenden, fügen Sie erst die Fußnote ein. Bei Word für 

Windows geht dies am schnellsten mit der Tastenkombination „Strg + Alt + F“, ansonsten 

über Verweise > Fußnote einfügen. Suchen Sie dann über Insert Citation nach der Referenz, 

die Sie zitieren möchten, und fügen Sie diese mit Klick auf Insert ein. 

Referenzen 

suchen und 

einfügen 

Referenzen 

bearbeiten 

oder löschen 

Zitate und 

Bibliographie 

aktualisieren 

Zitierstil aus-

wählen 

Automatisches 

Formatieren ein- 

und ausschalten 

 

https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/faq/EW/UBHD_Handout_EndNote_Online_01.pdf
https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/faq/EW/UBHD_Handout_EndNote_Online_02.pdf


 

 Universitätsbibliothek Heidelberg    Seite 16 von 19 

 

 

Abbildung 17 - Zitat suchen und einfügen 

 

Während des Schreibens können Sie im Prinzip jederzeit den Stil wechseln. Bevor Sie an-

fangen zu schreiben, sollten Sie sich allerdings überlegen, ob Sie einen Stil vom Typ Author 

Date bzw. Numbered oder einen Fußnoten-Stil benutzen möchten, da ein nachträglicher 

Wechsel zwischen diesen unterschiedlichen Stiltypen nicht möglich ist. 

 

 

Suchfeld 

Anzeige der gefundenen Referenzen 
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Abbildung 18 - Beispiel Zitierstil Author Date 

 

 

Abbildung 19 - Beispiel Zitierstil Numbered 

 

9.2.  Zitate im Text bearbeiten 
Falls Sie in den Zitaten Text hinzufügen und Seitenangaben zitieren möchten, markieren Sie 

das Zitat (1) und klicken Sie dann auf Edit and Manage Citations. Es öffnet sich ein Fenster 
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mit der Liste aller in Ihrem Dokument zitierten Referenzen (2). In der unteren Hälfte werden 

die drei Felder Prefix, Suffix und Pages angezeigt, in denen Sie Ihre Eintragungen vorneh-

men können (3). 

• Prefix: Angaben werden vor der Literaturangabe in der Klammer / Fußnote ange-

zeigt. 

• Suffix: Angaben werden nach der Literaturangabe in der Klammer / Fußnote ange-

zeigt. 

• Pages: Für die Eingabe einzelner Seitenangaben. Über den Zitierstil werden For-

mulierungen wie „S.“ automatisch hinzugefügt. Allerdings unterstützt nicht jeder Zi-

tierstil dieses Feld. Über eine Zitierstiländerung lässt sich ein Stil so ändern, dass er 

Eingaben im Feld Pages unterstützt. (s. dazu Anleitung zu Zitierstiländerungen in 

EndNote). In der Abbildung 20 wird ein Zitierstil dargestellt, der die Seitenangabe 

nicht unterstützt. Daher kann die Seitenangabe alternativ in das Feld Prefix eingetra-

gen werden. 

 

Abbildung 20 - Zitate im Text bearbeiten - Zitat anwählen (1), auf Edit & manage citations klicken, das zu bear-
beitende Zitat ist auch in der Zitatliste markiert (2), die Daten in die Felder Prefix, Suffix bzw. Pages eintragen 
und per ok bestätigen (4) 

 

Wenn Sie mit Word arbeiten und eine Referenz aus dem Text löschen möchten, benutzen 

Sie dafür nie die Delete-Taste, denn das kann Ihr Dokument beschädigen. Markieren Sie 

stattdessen im Text oder in der Fußnote das zu löschende Zitat und klicken Sie auf Edit and 

Manage Citations. Rufen Sie das Dropdown-Menü der markierten Referenz auf, wählen Sie 

1 

3 

2 

4 
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Remove Citation und bestätigen Sie die Auswahl mit OK. Das Zitat wird damit sowohl aus 

dem Text als auch aus der Literaturliste herausgelöscht. 

Wenn Sie in Ihrem Word-Dokument bei einer verwendeten Referenz einen Tippfehler entde-

cken oder feststellen, dass die bibliographischen Angaben in der Literaturliste nicht korrekt 

angezeigt werden, muss die Referenz in EndNote manuell korrigiert werden. Speichern Sie 

die Korrektur in EndNote ab. Klicken Sie anschließend in Word auf Update Citations and 

Bibliography. Zitate und Literaturliste werden automatisch aktualisiert. 

Falls Sie mit EndNote eine eigenständige Literaturliste unabhängig von Zitaten in einem Text 

erstellen möchten, bietet Ihnen die Universitätsbibliothek Heidelberg hierzu ein passendes 

Handout an. 

 

9.3.  Zitierstile 
Grundsätzlich gibt Ihr Fachbereich oder die/der einzelne BetreuerIn Ihrer wissenschaftlichen 

Arbeit den Zitierstil vor. An vielen Fachbereichen finden Sie dazu Angaben in den Hinweisen 

zur Anfertigung von wissenschaftlichen Arbeiten. Die Universitätsbibliothek Heidelberg hat 

für einige Fachbereiche Zitierstile entwickelt, die Sie über die Homepage der UB herunterla-

den können. Stimmen Sie sich in jedem Fall mit Ihrer/Ihrem BetreuerIn ab, welchen Zitierstil 

Sie verwenden sollen. 

In EndNote können Sie den Zitierstil über das Dropdown-Menü im Preview Subpanel aus-

wählen. Nach der Programminstallation stehen Ihnen ca. 500 häufig genutzte Zitierstile zur 

Verfügung, die Sie über das Dropdown-Menü zur Auswahl eines Zitierstiles mit Select 

Another Style oder über Tools > Output Styles > Open Style Manager aufrufen können. Wei-

tere Zitierstile können Sie von der EndNote-Homepage (Aufruf auch über Help > EndNote 

Output Styles) herunterladen. 

Falls Sie vorhandene Zitierstile verändern oder einen eigenen Zitierstil komplett neu erstellen 

möchten, finden Sie Informationen dazu in der Anleitung zur Erstellung eigener Zitierstile in 

EndNote. 

https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/faq/LV/UBHD_Handout_EndNote_Literaturverzeichnis_gestalten_01.pdf
https://www.ub.uni-heidelberg.de/schulung/literaturverwaltung/endnote/zitierstile/Welcome.html
https://archiv.ub.uni-heidelberg.de/volltextserver/30916/
https://archiv.ub.uni-heidelberg.de/volltextserver/30916/

